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1 ATAIOS DE TECLADO

W : Mover

E: Rotar

R: Escalar

Q: Pan

X : Cambia entre pivot local o Global.

Z : Cambia entre Pivote del objeto y centro del objeto.

V : Con la letra V pulsada podemos cambiar momentdneamente el pivote del objeto hacia uno
de sus vértices y luego poder mover ese objeto a partir de ese vértice.

CTRL: Con la tecla Control pulsada activamos el snap. Tanto para posicién como para rotacion.
F: Focus in object, o lo que es lo mismo enfocamos la vista en el objeto seleccionado.

También podemos hacer lo mismo haciendo doble clic en los objetos de la escena que aparecen
en la ventana Hierarchy.

ALT + LMB (botén izquierdo del ratén): Rotamos la vista alrededor del objeto seleccionado.
RMB: Rotamos la vista

ALT + RMB (botén derecho del ratén) : Zoom

CMB (botdn central del ratén) : Zoom

RMB+W: Avanzamos la vista hacia adelante.

RMB+S: Tiramos la vista atras.

RMB+A: Nos desplazamos hacia la izquierda.

RMB+D: Nos desplazamos hacia la derecha.

RMB+Q: Nos desplazamos hacia abajo.

RMB+E: Nos desplazamos hacia arriba.

CTRL + D: Duplicar objetos.

Barra espaciadora: Modo pantalla completa sobre cualquier ventana.

CTRL+ Alt+F : Mueve el objeto seleccionado hasta el centro de la vista actual.

El cento de la vista podemos manipularla con el F(Focus in object) para poder alinear unos
objetos con otros.



CTRL+Shift+F: Alinea cualquier objeto seleccionado a la vista actual. Nos puede servir para crear
una vista que nos pueda ser interesante y alinear la cdmara a esa vista para que cuando le demos

2 IMPORTAR / EXPORTAR

2.1 Exportar desde 3DSTUDIO MAX :

@‘E.H

AL E| JAamE

al play para activar el juego, veamos exactamente lo mismo que veiamos en el viewport.

En la captura se
aprecia como
hemos alineado la
camara a la vista
actual, de manera
gue veremos lo
mismo en unay en
otra.

Con la escena u objeto cargado.

[ e

Export files from 3ds Max

1) s

Export
=5 Export non-native file farmats from the

current 3ds Max scene,

(=% open »
(=

g Save As »
@ Import »

E} Export »

Export Selected

»

Max scene,

Export to DWF

@

DWF format.

Export only selected objects as non-
native file formats from the current 3ds

Export the current 3ds Max file in the

File > Export—> Export

O si queremos guardar un solo objeto, File>Export 2>
Export Selected.

Se nos abrird una ventana para nombrar al objeto y luego la

opcién que debemos escoger es .FBX

Se nos abrird otra ventana de exportacién en la que

debemos elegir lo que se va a incluir en la escena u objeto exportado, como cdmaras, luces ,
animacién y el tipo de geometria.

Units

Las unidades yo las suelo poner en
centimetros, si trabajas en centimetros
en Max. Damos a OK y ya hemos
generado el archivo.

2.2 Importar desde UNITY:

| Create | 3

Show in Explorer
Open

Delete

Import New Asset...

Import Package »
Export Package..

Find References In Scene

Select Dependencies

Refresh Ctrl+R
Reimport

Reimport Al

Sync MonoDevelop Project

I Folder I

Javascript
C# Script

Boo Script
Shadler
Compute Shader

Prefab
Material
Animation
Cubemap

Lens Flare
Custom Font
Render Texture
Physic Material
GUI Skin
Animator Controller
Avatar Mask

En la ventana de Project tenemos una carpeta por
defecto llamada Assets.

Si clicamos botdn derecho del ratén sobre ella
podemos crear una carpeta nueva.

Crearemos la carpeta de importaciones o import
assets o como la queramos llamar.



Dentro de esta crearemos otra con los objetos que traeremos de Max u otro programa 3D.

Max.

Create
Show in Explorer
Open
Delete
Import New Asset...
Import Packege
Export Package.
Find References In Scene
Select Dependencies
Refresh CtrlsR
Reimport
Reimport All

Sync MonoDevelop Project

En la ventana de la derecha aparecen los
objetos que contengan las carpetas
seleccionadas de la izquierda.

Si clicamos sobre cualquier parte de esa
ventana clic derecho del ratén, se nos abrira
un desplegable con la opcién Import New
Asset.

Aqui buscaremos el archivo .FBX generado
por la aplicacién 3D, en este caso 3D Studio

Una vez importado el objeto, lo podemos arrastrar a la escena.

Una vez en la escena y seleccionado, veremos a la derecha sus propiedades. En esta ventana de
la derecha cambiaremos la posicion numéricamente y su escala si lo vemos necesario.

3

CREAR OBIJETOS

Es muy facil crear objetos en Uniy. Aunque los objetos que nos permite crear el programa son
muy bdsicos, nos van a permitir trastear lo suficiente con el programa como para hacernos una
idea de las posibilidades que tiene.

[GameObject| Component Terrain Window Help

4

Create Empty
Create Other 13

Center On Children
Make Parent
Clear Parent

Apply
Break Prefab Instance

Move To View
Align With View
Align View to Selected

Ctrl+Shift+N

Particle System
Camera

GUI Text

GUI Texture

3D Text
Changes To Prefab
Directional Light
Paint Light
CtrlsAlt-F

Ctrl+Shift+F

Spotlight
Area Light

Tube
Sphere
Capsule
Cylinder

objetos basicos.

Plane

PREFABRICADOS y uniones entre objetos

Open
Dalte

Impert New Asset.
Imgort Package

Eport Pockage

Select Dependencies

Refresh [
Remport
Remport Al

$ync MonoDevelop Project

Las primitivas standard que podemos encontrar ,estan dentro
del desplegable GameObject—> Create Other.

Estos objetos los podremos modificar a nuestro gusto
moviéndolos rotandolos y escaldndolos.

La imagen que aparece en el apartado de atajos de teclado de
este manual, ha sido construida integramente con estos

— Los prefabricados es una manera de unir objetos de la escena
para que luego puedan ser duplicados como un conjunto y no
como objetos separados.

Vamos a crear dentro de la carpeta que habiamos creado
antes (la de Imported Assets u Objetos Importados), una
carpeta de objetos Prefabricados (ya sabes, con clic derecho
del ratén—> Create - Folder).



Dentro de esta carpeta haremos clic derecho del ratén sobre la ventana de la derecha y
crearemos el prefabricado con Create—> Prefrab.

Objetos sueltos pueden arrastrarse desde la ventana Hierarchy hacia el prefabricado
gue acabamos de crear, pero la idea es agrupar primero esos objetos para luego
incluirlos en el prefabricado, ya que no vamos a poder arrastrarlos todos a la vez.

En la ventana Hierarchy podemos ver que los objetos estan dentro de
un objeto llamémosle padre, del que cuelgan todos los demas. Este
objeto padre tiene el nombre de la escena que hemos importado en
formato FBX (en este caso pruebaunity).

Todos estos objetos aparecen de color azul.

Si duplicamos alguno de ellos veremos que las copias pasan a ser de color blanco.

Si arrastramos unos sobre otros, se crean vinculos descendientes entre ellos, es
decir, el objeto arrastrado pasa a ser hijo, y el objeto al cual hemos arrastrado el hijo, pasa a ser
el padre.

41 CREAR GAMEOBJECT
4 nity - Untitied - proyecta Uity - PC Mac: - UUNA vEZ €N este punto, lo que necesitamos para poder agrupar bien los

File Edit Assets | GameObject | Componet

= objetos, es crear un gameobject, para eso vamos a la pestafa
.
Create Other Gameobject—> Create Empty.

Center On Children

e — Lo renombramos como el prefabricado que hemos creado antes.

Este tipo de objeto no se representa en escena, digamos que es como un punto imaginario en
el espacio, pero lo podemos mover,rotar y escalar.Lo he llamado Caja de
Cubitos.

Debemos arrastrar los objeto que queremos que pertenezcan al
prefabricado en el nuevo gameobject.

Si esos objetos estaban en azul es porque pertenecian a la escena
importada, al arrastrarlos nos dird si queremos destruir su vinculo de
prefabricados, le diremos que si.

Aclaracion: Por defecto unity interpreta que cuando importamos una
escena de 3DStudio Max entera, los objetos forman parte de un grupo.

He arrastrado las cajitas Box al gameobject. Ahora ya podemos arrastrar el gameobject al
prefabricado de la ventana de Assets.

En resumen, los objetos se han arrastrado a un gameobject y este a su vez dentro de un
prefabricado.

El icono del Prefabricado pasa a tener la apariencia
de los objetos que tiene dentro.

Silo seleccionamos nos aparece una previsualizacion
a la derecha del todo, la cual podemos rotar.




4.2 MODIFICAR PREFABRICADO
Para modificar un prefabricado deberemos temporalmente desvincular los objetos que tiene
dentro.

Arrastramos los objetos fuera de su contenedor

En ese momento aparece el mensaje de que Losing prefab

This action will lose the prefab connection. Are you

perderemos la conexidn existente en el prefabricado. B et
Le decimos que nos parece muy bien y continue.

Cancel

Apareceran de color blancoy légicamente fuera del gameobject ,que yo llamé Caja
de Cubitos, como se puede apreciar en la captura de la izquierda.

Vamos a seleccionar el Gameobject (caja de cubitos ) y lo vamos a llevar a las
coordenadas que nos vayan bien, yo lo que he hecho es colocarlo en una de las
esquinas de la pared izquierda.

Ahora vamos a volver a vincular los objetos Box arrastrandolos de nuevo al
gameobject.

Lo seleccionamos y vemos que & Unity - tuto_unity_punto_S.unity - proyecto Unity -F
. . File Edit Assets GameObject Component Terr

siguen de color blanco. Si

M aplicamos cambios clicando

sobre Apply volveremos a tener los objetos y el gameobject de color

azul. Eso querra decir que el prefabricado queda cerrado de nuevo.

Default

Para ver los cambios que hemos realizado iremos donde pone Center y
lo pondremos en modo Pivot. El pivote del objeto esta en la esquina donde lo he colocado antes.

5 COLLIDER

Vamos a afiadir interactuacion a nuestro objeto.
El Collider es colision, es decir que box collider seria colision con forma cuadrada.

& ity - Untited - proyecta Uity -PC, Mac & i Standalone Como la parte inferior de nuestro prefabicado es un
File Edit Assets GameObject |Compenent||Terrzin  Window Help

Ad CuloShiteA cubo, he pensado que lo podemos usar de suelo, y los

cubos aplanados de los lados se pueden usar de pared.

Mesh
Effects

Navigation

Rigidbody
Character Controller

Seleccionaremos desde la ventana Hierarchy el cubo que
Sphere Collider

ceecoeee  NACe  de  suelo y clicaremos en el desplegable
Component—> Physics—=> Box Collider.

Audio

Rendering

Miscellaneous

Se crea una caja de color verde alrededor
del objeto, a la cual le podemos cambiar el
tamafio.

Yo la dejaré con el tamafio del objeto
porque no me interesa que interactie mas
alla del espacio que ocupa.

Haremos lo mismo con las paredes.



Al agregar el Box Collider al objeto, cualquier otro objeto de la escena chocara contra él si quiere
atravesarlo.

Si seleccionamos el objeto que contiene el collider, lo podremos ver en la ventana de la derecha.

R— He creado un objeto y he decidido cambiar el Box
Isgﬁ"_:;,'fh collider B Collider por el Mesh Collider.

Material None (Physic Material)

Eonee El Mesh Collider en lugar de tener una forma cuadrada,

Smooth Sphere Collisic

Mesh Plane001 B tiene la misma forma que el objeto original, de tal
manera que la colisién sera mucho mas realista.

Si clicamos botdén derecho sobre el mesh collider veremos que podemos borrarlo con la opcidn

Remove Component.

6 IMPORT PACKAGE

G \amos a incorporar un personaje que interactie con
;i‘:;f:;ﬁj;:f“ ; paredes y suelo. Para eso hacemos clic derecho sobre
Retseh Culk | LightCookis Assets (dentro de la ventana de Project)> Import
2ZZM E:E'HM‘ Package—> Character Controller.

Sync MonoDevelop Project P

Scripts.

LR Por defecto sale una ristra de componentes a importar,
simplemente le damos a import y nos quedamos tan
panchos.

Se afiade una carpeta llamada Standard Assets y dentro de
esta Character Controllers. Si la seleccionamos nos salen 2
opciones, tercera personay primera persona. En la tercera persona se ve
el personaje que controlamos y en la primera persona digamos que

== Character Controllers

nosotros seriamos el personaje y veriamos a través de una camara.

Arrastramos el First Person encima del cubo que he creado para generar
el suelo o lo que hayas creado para esto, en realidad vale cualquier objeto
con un Collider.

Le podemos dar al Play que hay en la pantalla de unity arriba, para que
comience el juego.

Veremos que nosotros somos el objetoy lo controlamos con el ratén para

Character Controllers|

rotar la vista y con el cursor para movernos. Chocamos con las paredes
porque son un Collider. Si damos al play de nuevo salimos del juego.

Si seleccionamos Main camera podemos cambiar por ejemplo el fondo a negro.



7  CREAR MATERIALES

Por defecto cuando importamos una escena, aparece una carpeta
de materiales. Yo en el ejemplo tengo 2. Uno gris y otro con puntitos
blancos en fondo negro.

= Materials

Vamos a borrarlos los 2 y dejar vacia la carpeta.

o Flder Clicamos botdn derecho en la zona vacia y Create->Material.
o _ .
wmsae  CON €l nuevo material seleccionado,en Ia
aw : ventana de la derecha, donde pone Shader S
S Cm=]  clicamos y lo desplegamos para elegir el :
wer e Bumped Specular(por ejemplo). Decal

En la ventana Project, dentro de la carpeta Assets, vamos a crear
dentro de Imported Assets una nueva carpeta llamada texturas.

PREFABRL. | TEXTURAS

Entramos en la carpeta y Clic derecho en zona vacia=> Import New
Asset, elegimos la textura y aparecera en unity.

También podemos arrastrar los mapas a unity directamente.

Volvemos a nuestro material creado desde
unity con el Shader Bumped Specular, al
cual podemos arrastrar las texturas
afadidas anteriormente.

Si arrastramos a donde pone normal map
una textura bump, automaticamente nos
va a generar un normal map a partir de esa
textura.

8 ANADIR LUCES

ity = projects Uity = PCMacElinax sandzione . Una de las formas que tenemos de crear luces es irnos a la

5 Component  Terrain - Window Help . .
Create Ematy Ci-shife pestafia GameObject-> Create Other.

, Particle System

Camera ,
G Tot En ese menu desplegable nos aparecen todas las luces, desde

Make Parent GUI Texture

o et Directional Light hasta Area Light.

Apply Changes To Prefab

Center On Children

Directional Light

Point Light Si clicamos sobre Point Light por ejemplo se nos cera una luz
_X Spotlight

- puntual en la escena con sus propiedades en la ventana de la
derecha.

Break Prefab Instance

Move To View Crl+Alt+F

Rendering

Otra forma de crear luces es, irnos a un objeto que queramos que genere
luz y donde pone Add Component->Rendering—> Light. Automaticamente
aparece una luz vinculada a ese objeto.

Las propiedades de esa luz se ven como siempre en la ventana de la
derecha.




® ¥ Light
Type

Range

None (Texture)

No Shadows

Inity - tutoZono.unity - proyecto Unity = PC, Mac & Linux Standalont

Assets GameObject Component Terrain  Window
Undo Inspector Cirl+Z
Redo Cirl+ ¥

Range es el tamafio de la esfera que rodea la luz y que indica hasta donde
llega su radio de accion.

Cut Ctrl+ X
Co Ctrl+C . . . . .
st cutew Color, el color de la luz, e intensity la intensidad con la que brilla.

Duplicate CtrieD
Delete Shift+-Del

Shadow Type: Para activar las sombras en un Point Light, debemos
configurar lo siguiente.

Frame Selected F
Find Ctrl+F
Select All Crl+A

refences- Nos vamos a Edit=>Project Settings=> Player.
Play Cirl+P
Pause Ctrl+Shift+P
Step Ctrl+Alt+P

En la ventana de la derecha, en Other Settings=>Rendering Path, debemos
Other Scttings elegir Rendering Path—>Defferred

Load Selection 3

Save Selection 3

= Lighting.
Render Settings Tags & g

NavMeshLay
Audio

Network Emulation 3

s . Ahora ya podremos ver sombra con

R R ynamic Batching las luces Point. En teoria deberiamos

verlo en la escena directamente, pero si no fuese asi, ten por seguro que cuando le des al play
para activar tu juego, las sombras aparecerdn en escena.

Graphics Emulation »

Briconsejo: Para crear la luz de por ejemplo una ldmpara, lo ideal es crear la luz justo sobre la
bombilla y hacer un prefabricado de la lampara y la bombilla, los dos objetos juntos, para
poderlos luego multiplicar si es necesario.

9 SISTEMAS DE PARTICULAS

Para afiadir un sistema de particulas, lo Unico que hay que
hacer es clicar sobre Create (debajo de Hierarchy)-> Particle
System.

File Edit Assets GameOtb

A la derecha se despliega la ventana con todas las opciones
del sistema de particulas.

Particle System

Si desplegamos Emission, el valor Rate es el nimero de particulas que se van
a representar en escena.

Si desplegamos Shape, podemos cambiar la forma a partir de la cual se
emiten las particulas y cambiar sus dimensiones en los 3 ejes de
coordenadas.Random direction cambia la direccion de las particulas de una
manera aleatoria.




Sobre la pestafia Emission existen las opciones generales.Entre las cuales tenemos la velocidad

(start speed), el tamafio (star size), la vida media de las particulas (start lifetime), el color (start

color), la gravedad y por ejemplo el Prewarm que sirve para cuando paramos la simulacion y la

Lot i volvemos a reanudar, vuelva a empezar desde donde
10 . lo dejamos y no vuelva a empezar de 0.

La pestafia Size Over Lifetime muestra una curva para
poder modificar el tamafio de las particulas de
manera que empiecen siendo pequefias y acaben
siendo mas grandes, o al reves.

La pestafia Renderer muestra el material asignado a las
particulas.

Si clicamos en la pelotica que hay a la derecha de Default-
Particle aparecen los materiales que tenemos en el
proyecto y que podemos asignar a las particulas.

Para incorporar a la escena sistemas de particulas ya definidos como por ejemplo fuego,humo
agua y algunos efectos mas, solo hay que hacer clic derecho sobre Standard Assets o Assets o la

carpeta donde queramos ponerlos dentro del apartado Project , y desplegar la carpeta. A
continuacién arrastraremos los prefabricados sobre la escena y retocaremos sus valores para
que se asemeje al efecto que estamos buscando.

10 SIMULACIONES FISICAS

Antes hemos visto como funcionan los Collider.Son objetos que no se pueden atravesar.

Se pueden aplicar a estos objetos colliders en forma de cubo o de esfera, o tambien que se
adapten a la forma del objeto con el Mesh Collider.

Ahora vamos a aplicarles simulacion fisica de manera que interactuen con el escenario y
personajes.

Vamos a convertir un Collider en un Rigidbody. Para esto tenemos 2 opciones.



La primera seria irnos al desplegable de arriba Component—>Physics>RigidBody, teniendo el
objeto seleccionado, dentro de las propiedades el objeto, en el Inspector, darle al boton Add
Component por el que accedemos al mismo menu.

Riqidbady a Al agregar el Rigidbody al objeto, si este esta apoyado sobre
alguna parte del escenario, posiblemente no pasara nada,
pero si este esta elevado, al darle al Play para comenzar el
juego, el objetd se precipitara por efecto de la gravedad y
caera sobre otro objeto que sea un collider, rebotando
segun el caso.Logicamente la opcidon Use Gravity debe estar

seleccionada para que pase esto.

Un objeto RigidBody nunca debe interseccionar con otros objetos Collider, ya que chocarian
desde dentro y posiblemente desaparecerian.

11 EISCRIPT

El script se puede decir que son las lineas de comandos que hacen interactuar los elementos en
unity a través de un lenguaje de programacion.

Es la introduccion de codigo en unity a través de Javascript,C# y BooScript, segun el lenguaje que
mas te convenga o sepas para programar.

Para empezar lo que podemos hacer es crear una
=== | carpeta dentro de Project=>Assets , llamada Scripts.

Open C# Script
Delete

Boo Script
Import New Asset.

.| amese Dentro de esta, hacemos CLIC DERECHO-> Create y

Export Package. Prefab

wes  @legimos un lenguaje.

Select Dependencies J—

Refresh CtrisR Cubemap.

Reimport Lens Flare

i VOY @ elegir por ejemplo C# Script.

Render Texture

Reimport All

Sync MonoDevelop Project

Physic Material
GUISkin

Nos aparece un icono llamado NewBehavior. Cambiaremos su

T3 sy Cshar - ARGBERIPTS\HOLA QUE TALcs" - MomoDeveop-Uniy e ==

|| Ere Es¢ Yew Sewch Project Buid Bum VersiopContol Tooks MWindow Hep

| ag . .

S — nombre. Vamos a crear un mensaje en unity, y por eso
# ‘—Asscmp::l:ljsh:lp R
# [ Assembly-CSharp{

B . Q Assembly-UnityScr

7™ g | llamaremos al archivo creado, HOLA QUE TAL. Por poner un

U i | ejemplo.

Si hacemos doble clic sobre el, se nos abre la ventana para

Solution loaded. B:5 NS | Feedbock| @O0 EJTaklit

introducir cédigo.

En esta ventana nueva, vemos en verde dos mensajes, el primero use esto para inicializacién.
Esto quiere decir que lo que escribas despues del void start aparecera solo una vez al iniciar el

juego.



A continuacién el segundo mensaje es Update is called once per frame, es decir, que se

actualizara en el juego en cada frame.

Vamos a crear un mensaje que se repita cada frame, pasa eso vamos despues del void update y

// Update 1s called once per
escribimos : Debug.Log(“HOLA QUE TAL”); void Update (] {

| pebug.Log ("EOLA QUE TAL"): |
H

il Assembly-CSharp- A Le damos al disquette de grabar.
File Edit  View Sear

W= El . .
o Para que surta efecto , debemos arrastrar el script a un objeto de la escena y para
B ———— S SESMSSNSSS ©SO Crearemos un GameObject yendo a
GameObject | Component  Terrain - Window Hel
Ers=iamhy Lt GameObject>Create Empty. Lo podemos llamar

Mensaje de la maquina, por ejemplo.

Arrastramos el script dentro del GameObiject, y ahora si ,podemos darle al

Play para activar nuestro juego.

Abajo a laizquierda, al lado de Project, tenemos la pestafia Console que es

la que nos devuelve el mensaje que hemos creado.

Si no aparece el mensaje una y otra vez, es posible que hayamos cambiado algo sin darnos

cuenta. Podemos volver a empezar creando un script y un gameobject nuevos.

Aparecen muchos mensajes, porque al ponerlo despues del void update, aparece un mensaje

por cada frame.Paramos el juego y en Console le damos a Clear, para borrar los mensajes.

Ahoralo que deberiamos hacer es ,cortar-pegar el debug.log del mensaje

// Use this for initialization
void Start () {
|Deb.:lg.]:.og ("HCla Que tal™): |

después del Void Start.

Le damos a grabar, y ahora solo aparece el mensaje que habiamos

1 Play Error Pause

Object)

creado ,una sola vez al iniciar el juego.



